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Aviso: Después de terminar cada sesion es necesario pulsar el icono “salir’ en la parte superior a
la derecha para evitar dejar licencias bloqueadas.

Qué es Bibleworks

Descripcion: Base de datos que contiene 112 traducciones de la Biblia en 30 lenguas, ademas de los
textos originales con analisis morfologico. Proporciona diccionarios griegos y hebreos entre otras
herramientas para el anadlisis. Incluye avanzadas herramientas para analizar, comparar textos,
buscar y exportar resultados.

Contenido:

Productor: Editorial Aranzadi

Como se accede a Bibleworks

¢ Desde la pagina principal de la biblioteca, pinchar en el botén “Bases de Datos en Red”.
e Escribir en la casilla “Bibleworks” y presionar el boton “Buscar”.
¢ Hacer clic en el enlace “Bibleworks”.

bibli®teca @ Universidad de Navarra

Usted estd en: Universidad de Mavarra = Biblioteca » Bases de datos en red » Resultados de la busqueda

1 registros encontrados. Otra

. busqueda
En esta pantalla se presentan desde el registro 1 hasta el 1. fusgueda

Cuando el acceso a alguna base de datos requiere user name y password se indica debajo del titulo. Tome nota de ellos
para poder acceder,

BibleWwarks Base de datos que contiene 112 traducciones de |a Biblia en 30 lenguas, ademads de los
textos originales con andlisis morfoldgico. Proporciona diccionarios griegos v hebreos entre
otras herramientas para el analisis. Incluye avanzadas herramientas para analizar,

Rescame iR FIsEieme comparar textos, buscar v exportar resultados,

Terma:Humanidades y Ciencias sociales
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{Como se divide Bibleworks?

¢ Bibleworks se divide en tres ventanas principales:

1. Search Window: es la ventana desde donde se lanzan y realizan las
busquedas.
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2. Browse Window: En esta ventana se pueden ver versiculos individuales

en contexto (en una sola version de la Biblia) o en multiples versiones de
la Biblia.

I Gen 31 The First Sin and Its Punishment j "
t}.|ma jlﬁenesis j|3 j|1 j

E¥V Genesis 311 Mow the serpent was more crafty
than any other beast of the field that the LORD
God had made. He said to the wornan, "Did God
actually say, "You shall not eat of any tree in the
garden"?"

B IENEY

kI Genesis 3:1 Mow the serpent was more subtil
than any beast of the field which the LORD God
had made. And he said unto the woman, Yea,
hath God said, Ye shall not eat of every tree of
the garden?

HAE Genesis 31 Mow the serpent was more crafty
than any beast of the field which the LORD God
had made. And he said to the waoman, "Indeed,
has God =aid, "ou shall not eat fram any tree of
the garden "




Universidad de Navarra
Servicio de Bibliotecas

3. The Analysis Window: esta ventana muestra informacién sobre las
palabras que se muestran en la “Browse Window’. Conforme se mueve
el ratéon sobre cada palabra, el anadlisis de cada una, aparece en esta
ventana.

ford Analysiz I Rezource Summar_l,ll Llzer Nu:utesl Editor I

T ext footnotes for KA version

. | TSK Gen 31
LJV Notes (Gen 3:1) j “Maw.
Gen 31315
Matthew Henry Notes: lsa 271
_ Mat 1016
Chapter: 3 2Co11:3
2Co11:14
The story of this chapter is Rev 123
haps as sad a story (all Flev 202
F'E_r P ; ¥ *serpent.
things considered) as any *he zaid.
we have in all the Bible. In Eum4212i:|23'29
. CC A
the foregoing chapters e 1P 27
have had the pleasant view *fea, hath. Heb. ¥
of the holiness and ma: ig
| al &
happiness of our first Mat 49

parents, the grace and

Frarmiwe AF A med A A e m

{Qué posibilidades nos ofrece el menu principal?

¢ El menu principal que encontramos en la barra superior de navegacion
podemos acceder a siguientes opciones:

File ' Wiew Search Tools Resources Window Help

e File: a través de esta opcion vamos poder abrir el editor de
texto, guardar la lista de versos encontrados, imprimir y
establecer opciones de impresion.

¢ The View menu: este menu nos permite:

¢ Choose Display Version(s).... podemos cambiar las
versiones de la Biblia que se muestran en la “Browse
Windows”’.

e Version Display Order: establece el orden en el que
se muestran las distintas versiones de la Biblia en la
“Browse Windows”’.

e Change Verse List Sort Order: permite cambiar el
orden en los resultados se muestran, por defecto son
el orden de los libros en inglés.
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e Show / Hide: oculta o muestra varias de las
alternativas de texto en la “Browse Windows”’.

¢ New Browse Window: nos abre una nueva ventana
busqueda.

- Search Menu: entre la diferente posibilidades podemos
destacar:

e Choose Search Version .: seleccion de la version en la
que se lanzara la busqueda.

e Detailed Statistics Windows: muestra informacion
estadisticas de la ultima busqueda.

e Cross Versions Search Mode: podemos lanzar la
busqueda de diferentes modos:

e Search Only Current Search Version:
opcion por defecto que busca en la
version elegida.

e Search All Display Versions: la busqueda
se realiza en todas las versiones de la
misma lengua elegidas.

e Search and Display All Same Language
Versions: Como la opcidn anterior busca
en todas las versiones de la misma
lengua elegidas, pero si encuentra algun
resultado en alguna versidon de la misma
lengua no seleccionada, la activa para
que se muestren sus resultados.

e Search and Prune All Same Language
Versions: Es similar a la anterior, pero si
alguna versién no tiene ningun resultado
se excluye de la seleccion.

* The Tools Menu: este de menu herramientas nos permite:

* “World List Manager” y ‘Verse List Manager’:
podemos trabajar con listados de palabras o de
versiculos.

¢ Parallel Versions Window: permite trabajar con
diferentes versiones en ventanas paralelas.

e Copy Center: mediante esta opcion se copia texto a
diferentes destinos o formatos.

e Export Database: exporta texto (secciones muy
extensa) al disco duré o a un disquete.
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® Repor Generador: genera informes detallados de

versiculos o rangos de versiculos, de morfologia,

sintaxis, etc.

* The Resources Menu: mediante este menu podemos encontrar
varios tipos de recursos como son: gramaticas griegas y hebreas,
mapas, diccionarios, léxicos, etc. También se puede acceder a

recursos externos de Internet.

* Finalmente ‘“the Window Menu” permite abrir otra copia de
Bibleworks y “The help mend’” nos muestras diferentes opciones de

ayuda.

{Como se realizan busquedas?

¢ Para realizar busqueda hay que lanzarlas desde la “Search Window”. Esta
ventana situada en la izquierda se compone de la siguientes opciones:

o Command Line: en ella introducimos el texto a buscar en la version o
versiones elegidas. Bibleworks requiere un lenguaje propio para
realizar las busquedas. La idea es que cuando se introduce una
palabra o palabras a buscar estas deben ir precedidas de un signo que
especifica la clase de busqueda que se quiere lanzar.

vlzls ¢ |5l el #lnl izl o

RE0 ‘.entnnces

v ®

Tipo de Signo Ejemplo Resultados de la busqueda

Busqueda

Palabra . (punto) .jesus Encontrara todos los versiculos

simple que tengan la palabra jesus

Varias . (punto) .jesus dijo Encontrara todos los versiculos

palabras que tengan la palabras jesus Y
dijo

Una | (Barra) ljesus maria Encontrara todos los versiculos

palabra o que tengan la palabra jesus o los

otra que tengan la palabra maria

Frase ‘ (apostofre) ‘Simoén Pedro | Encontrara todos los versiculos
que tengan la palabra Simén
seguida inmediatamente de
Pedro

Combinada | () parentensis | (.jesus Encontrara versiculos que tengan

maria)/(Simé | o las palabras jesis y maria o
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| | | n Pedro) | Simon y Pedro. |
Frases ; (punto y ; La funcién es la misma que para
lineales coma) buscar frases pero esta dirigido a

busquedas complicadas ya que es
mas rapido.

Para mas informacion sobre las distintas formas de interrogar a la base de
datos conviene visitar la opcion Help > Online Help Contents > Command
Line Examples.

CAB

o Command Line Version Button : Este botén situado en la
parte izquierda de la linea de comando. Nos muestra la abreviatura
de la version de la Biblia que estamos buscando. Asi mismo si lo
presionamos no ofrece varias posibilidades de las cuales destacamos:

1. Chose Search Version: se selecciona la version de la Biblia
donde se va a buscar. Asi mismo se abre una ventana que
nos va permitir elegir entre ‘“Search Only Current Search
Version”, ‘“Search AIll Display Versions”, ‘Search and
Display All Same Language Versions”, “Search and Prune
All Same Language Versions”. Estas opciones se han
explicado anteriormente. (ver pagina 4).

B Choose Search Yersion Ed

Chooze the werzion that pou want to zearch by clicking an the
checkbox nest ta the name af the version.

@ Albanian -
@ Bulgarnian
@ Catalan
@ Cuyrillic
@ Czech
@ Danizh
@ Dutch

@ Englizh
@ Finnizh
@ French
Ll I [Sormaen

_[KNQEN

Search Only Curent Search werzion.

[Search Al Drizplay "-.fersicuns.
Search and Dizplay &ll S ame Language Yersions.
Search and Prune All 5ame Language Versions.
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2. The Choose Display Versions(s) Window: mediante esta
ventana podemos elegir que versiones de la Biblia se van a
mostrar en el Browse Window. Basta con seleccionar las
versiones deseadas en la venta emergente.

Choose the wersions that vou want to dizplay by clicking on the
checkbox nest ta the name(z] of the verzion(z].

R —
@ Bulgarian

@ Catalan

@ Cyrillic

@ Czech

@ Danish

@ Dutch

& English

@ Finnish

@ French

@ German j
[~ Show Only sctive Languages LCancel | 0k I

o The Successful Search History Button: con esta pestaiia desplegabe

w
podemos encontrar las busquedas que han tenido resultados. J

CAH H j e
CAB Moisés =
BGT eyereto

KW the

LBA .de
WTT .52

WIT .OTI9R

WTT QMR
BGT emounoew
BGM moLsw
WM TN
CAB .principio
CAR encontrd
LBA agui

RGO entonces
REO ‘en todo animal
REO0 Y dijo Dios
RED .pedro

RGO "Siman Pedro
REOD ; Simdn Pedro
CAB soberhia

CAB s soberbia
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The Common Search Utilities Button: ﬁ este botén nos permite
seleccionar funciones comunes de este programa como son los listados de
palabras y versiculos, estadisticas, los ejemplos de como buscar en la base
de datos, etc.

P e T TR e « .
Tabs: EEEE Iﬂﬂﬂﬂﬂlﬂﬂ_ﬂﬂ . Con estas 12 pestafias

se puede trabajar en 12 busquedas diferentes con las diferentes
caracteristicas que hayamos elegido guardandose los cambios en cada una.
Cada tabla tiene un menu contextual al que se puede acceder pulsando con
el boton derecho del ratéon sobre la pestaila que nos permite: limpiar la
tabla, guardarla en un disco, cargar una guardada, limpiar la busqueda, etc.

Clear tab 7

Clear all tabs [except curent]

Freeze tab 7 contents

Save Tabsz to Digh
Load Tabs from Disk

Clear 5earch “window history
v Enable Search ‘window histomy

The History Back Button:-“ﬂﬂ . Este botéon almacena el historial de las

diferentes acciones que hemos realizado con Bibleworks, lo cual nos permite
volver a revisar acciones ya realizadas.

The Search Window Verse List Context Menu: pulsando con el botén

derecho del ratén sobre una busqueda de versiculos se nos va abrir un menu
contextual que nos va permitir diferentes posibilidades:

Copy Lizt to Editar
Copy Lizt ta Clipboard
|t List

Harizontal List Boxes
Wertical Ligt Bowes
Auto-Sizing List Bores

v Werze List Box + Text
Werze Ligt Bow + Text OMLY
Show Entire Werze
Show Form Instead of Lemma

1. Copy List to Editor: para copiar la lista de versiculos encontrada al
editor de Bibleworks

2. Copy List to Clipboard: podemos copiar la lista de los versiculos al
portapapeles de Windows.

3. Invert List: muestra todos los versiculos de la version que no se
encuentran en la lista.
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4. Horizontal List Boxes: reconfigura la ventana de busqueda de
manera que solo las referencias de los versiculos son mostradas y
no el texto completo. “The Version Word List” (listado de
palabras) y “Word Statistics List Box” también se muestran.

MES
la 22391 =] [cepachzzs +]
soberbia 27

Ceud:14 ™4

2Ch 32257 -
2Ch 3226 2 -
Tob 4:13 %3
Jdt 8:10
2Ma 736
Psa 19:13
Prog:13*3
Pro 30:32 *2
Sir 107 T2
Sir 10012
Sir 1013+
Sir10:18 =3
=] |sir 158 "2
Sir 26:26
situaran 2 = 15a 13:11
situaréds 1 Jer13:9*4
situarse 1 Jer 48:29
situd 5 Jer 4316 =3
sivan 2 Dan 11:12
siza 1 Dan 11:36
smo 7 200127 2
s0 15
soa 1
s0an 5

5. Vertical List Boxes: es similar a la opcidon anterior pero la ventana
de busqueda se muestra vertical.

vlelsle slelrlslslulnlz] ]

™ i

situaran 2~ [la 22391 = [CeB2thiz2s ]
situaras 1
:ﬁﬂz";‘a ) 2Ch 32:25 ~
e 2Ch 32426 -
sizd 1 Tob 4:13

Jdt 9:10

6. Verse List Box + Text: en la ventana de busqueda se muestren el
texto de los versiculos localizados.

7. Verse List Box + Text ONLY: en la ventana de busqueda se
muestren el texto de los versiculos localizados y desaparecen el
resto de ventanas.
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IR C R CIEA R KT R MR I

oo o

DEIR=RE R |2 soberbia en tu corazdn vy olvides 4

2Ch 322572 .. domind la soberbia, por lo que la oo
2Ch 3226 "2 .. la soberbia, y con él los habitantes #
Tob 4:13*3 ... la soberbia hay perdicidn v mucha _
Jdt 9:10 ... la astucia de mis labios al esclavo
2ha 730 ... la alianza con Diog de una vida ete
Psa 1813 ... siervo también de la soberbia, que |
Prog: 133 . la arrogancia vy la soberbia, la mala

8. Show Entire: esta preferencia reconfigura la “Search Window”
con lo que se muestra el texto completo de cada versiculo.

rlzlzle 5ol #lslelolnlz] ]

oo o=

DETERE S =rtre la soberbia en tu corazdn y
olvides a Yahveh, tu Dios: el que te
sacd de la tierra de Egipto, de la
casa de la esclavitud;

2Ch 32:25 %2 Pero no correspondid Ezequ as al
beneficio recibida, sino gue le damingd
la soberbia, por lo que la cdlera divina
se encendid contra él, as como
contra Juda y Jerusalén.

L Iv L]

9. Show Form Instead of Lemma: en una busqueda morfolégica la
lista de versos mostrara las formas de los diferentes lemas.

e The Word and Verse History Listboxes: seleccionando la opciéon en el
menu superior View > Show/Hide podemos acceder al historial de
versiculos consultados y palabras buscadas mediante ventanas
independientes.

({Como consultar los resultados?

Los resultados encontrados en la ventana de busqueda ‘“The Search
Window” se muestran en la ventana de navegacion “Browse Window”
situada en el centro de la pantalla. Cuando se hace clic en un versiculo se
muestra el texto en dicha ventana. Esta se compone de diferentes opciones
Si se pulsa con el botén derecho del ratéon sobre la parte superior de dicha
ventana se presenta distintas opciones:

10
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e o - g O e L S ==
* [ MAS Gen 7:1 161
Mo 22 122 & 5 4 Oy
[Gen 7:1 The Great Flocd - ﬂ
INf-\S leenesis j|? j|1 j

E¥ Genesis 7:1 Then the LORD said to Moah,
"5ointo the ark, you and all your househald, for |
have seen that you are righteous before me in this
generation.

kM Genesis 7:1 And the LORD said unto Moah,
Come thou and all thy house into the ark; far thee
hawe | seen rightecus before me in this generation.

HAS Genesis 7:1 Then the LORD said to Moah,

L L ) I I I e [ IR

o Show Current Verse: muestra en la parte superior de la ventana
de navegacion (Browse Window) la referencia del versiculo que se
esta mostrando y la version de la Biblia.

& ¥ CAB Gen 1:1

o Show Outline Heading: seleccionando esta preferencia se ocultan
y muestras las diferentes opciones que viene en la parte superior
de la Browse Window.

o Show Browse List Boxes: con esta barra menu indica la referencia
completa de la versidbn que se esta consultando. Ademas
desplegando las diferentes pestafias podemos ver las otras
versiones seleccionadas o afadir nuevas no incluidas en la
consulta. Con lo que se pueden consultar directamente la version
de la Biblia que deseemos.

|28 || Genesis = =oE
o No Browse Window Header: esta opcion oculta todas las opciones
de la parte superior de la barra de menu.
The Outline List Box: en esta casilla podemos ver una pequefia

descripcion del versiculo que se esta mostrando. Al ser desplegable nos
permite seleccionar el versiculo que deseemos.

I Deu 1315 Law conceming Withesses j ﬂ

The Browse Window Options Button: “= muestra diferentes opciones
de la ventana de navegacion:

11
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Toggle Strong's Numbers: muchas de las versiones de Bible
Works tienen numeros asociados a frases o palabras, esta opcion
los oculta o muestra.

Toggle Analysis Window: oculta o muestra la ventana de analisis
situada en la parte derecha.

Toggle Version Notes: oculta o muestra notas de traducciéon o
informacion sobre cada version.

Toggle Word Tips: sirve para activar o desactivar los léxicos o
glosas que incluyen algunas versiones de la Biblia.

Choose Display Version(s) y Set Version Display Order: son
opciones que permiten determinar que versiones se muestran y
en que orden.

New Browse Window: abre un “Browse Window” adicional, pero
que no tienen todas las caracteristicas del principal.

New Word Analysis Window: abre una nueva ventana de analisis.

The Browse Window Text Area: parte inferior de la ‘“‘Browse Window”
es donde se muestra el texto de los versiculos. Esta ventana esta
conectada con la ventana de busqueda y la de analisis. Sus
caracteristicas son:

Si se hace doble clic en una palabra esta se mostrara en la ventana
de busqueda.

Si hacemos doble clic en la siglas de una version esta sera la
version sobre la que se lanza la busqueda en la ventana de
busqueda ‘“Search Windows”’.

Moviendo el ratéon sobre cada version se mostrara informacion
adicional en la ventana de analisis.

Asi mismo se puede buscar una frase directamente marcandola, y
pulsando el botén derecho del raton y seleccionando la opcion
“Search for phrase”.

12
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&« v IPS Gen 1:1 1
He 820 a3 J oD
IGen'I:'I Six Diays of Creation and the Sabbath j ﬂ

I.JF'S leenesis j|1 j|1 j

0eY Genesis 1:1 [IRUEREDGIGEREND created the j
hesvens and the earth.

Search for Phraze
ORA Genesis 1:1 In the Copy Phrase to I:l:u!'nmand Line
Copy Phrase to Editar

heaven, and earth. )
Copy Phraze to Clipboard

BV Genesis 1:1 In the  Change Color of Selected Text
the heavens and the ez Open Calar Selection “Windaw
Clear Hit Highlighting

JPE Genesis 1:1 M THE

e Look up in talian dictionary online

Lookup in hyperdictionarny anline

KV Genesis 1:1 In the beginning God created the
heaven and the earth.

e Setting the Browse Mode b : este boton nos permite visualizar los
versiculos en la ventana de navegacion de dos formas diferentes. El
texto completo de la version sobre la que lanzamos la busqueda o
visualizar el versiculo de la version donde buscamos en las diferentes
versiones seleccionadas. Esta opcion es muy util para comparar
diferentes versiones.

® Menu contexual: si pulsamos con el botéon derecho del raton sobre el
area de texto de la ventana de navegacion (The Browse Window Text
Area), nos vamos a encontrar con las siguientes opciones:

o Search for Pharaseo or Word: dependiendo si hemos
seleccionado un frase o palabra, me lanzara una busqueda en
dicha version, de la palabra o frase seleccionada.

Search on Word

Lookup in Default Bible Dictionany
Lookup in Bibletorks Maps
Append to Command Line

Change Color of Selected Text
Open Color Selection YWWindow
Clear Hit Highlighting

Look up in ltalian dictionary online
Lookup in hyperdictionary online

o Append to Command Line: esta opcion afiade a linea de comando
de la ventana de busqueda la palabra seleccionada.

13
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o Change Color of Selected Text y Open Color Selection Window:
mediante estas opciones podemos cambiar el color del texto
seleccionado y establecer los colores que mas acorde con nuestras
preferencias.

o Clear Hit Highlighting: limpia los textos seleccionados hasta la
siguiente busqueda.

o Lookup in Default Bible Dictionary: para la busqueda de la palabra
en el diccionario establecido por defecto.

{Que herramientas de analisis disponemos?

La ventana de analisis (The Analysis Window) esta situada en la parte
derecha de la pantalla principal de Bibleworks. Se compone de 4

pestafas:

‘e ord Analysis | Resounce Summar_l,ll Ilzer Nu:utesl E ditar I
BGM tMorphology + Gingrich

Word Analysis: recoge herramientas de analisis lIéxico y
morfolégico.

Resource Summary Window: sumario de los recursos
léxicos y gramaticales relacionados con las palabras en
griego y hebreo en la Browse Window. A medida que se
mueve el ratéon por las diferentes palabras la informacién
se va actualizando.

User Notes Tab: editor de notas de Bibleworks.

The Editor Tab: editor de Bibleworks que tiene
caracteristicas de un procesador de texto, permitiendo
hacer enlaces, etc.

Word Anadlisis: Esta ventana nos ofrece varias herramientas:

14
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‘whord Analysiz | Resource 5ummar_l,l| Uszer Motes u:I E ditar I

Test footnates for FJY wersion

' x| TSK Gen 111

LIV Notes (Gen 1:1) j *heginning.
Fro8:22-24

Matthew Henry Notes: Book: Pro 16:4

. Mar1313

Genesis Joh 113
Heb 1:10

We have now before us the holy 1o 1:

. . *God.
Bible, or book | for 50 Bible Exo 2011
signifies. WWe call it the book, by Ewo 31:18
way af eminency; far it is :\JEELIEEEE
incamparably the best book that JDEI:: 613
evet was written, the book of Job 204
books, shining like the sun in the Psa 8

i Fza 336

firmarent of learning, other Plog 335
valuable and useful books, like Pea 851112
the moon and stars, borrowing Pza 965
their light from it. We call it the Ez:]gi%g
holy book, because it was written Pag 10430
by haly men, and indited by the Pza 115:15
Holy Ghost; it is perfectly pure ESEEE
from all falsehood and corrupt F'z:13423
intention; and the manifest Psa136:5
tendency of it is to promote Pza 146:6

. Fza 145:4-5
haoliness armong men. The great Pro 319
things of God's law and gospel Pro 82230
are here written to us, that they Ecc 121
might be reduced to a greater :z: ES;E
certainty, might spread further, lsq 40028

o The Word Analysis Tab: esta ventana muestra informacion sobre el

léxico cuando se mueve el cursor por encima del texto en la ‘“Browse
Window”.
La informacién varia dependiendo de la naturaleza del texto, para textos
en griego se muestra la entrada correspondiente al diccionario en
griego, para texto en hebreo se muestra la informaciéon morfolégica
correspondiente en un lexicon hebreo.

15
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Wwiord Analysiz I Fesource Summar_ul Uszer Mates n::I E ditor I
W Tk Morphology + Holladay entry

I:I"'ﬁlji_i noun commaon masculing plural absolute

Hols4 77178

TR & 0WIOR 1 TIOR (ca B0 ), TN
Ot 3247, 2K 1721 KE, Hb 1118, On 1122 1, most oft. in
Jb @1 =) — 1. a God/god Ps 133, k81-9153h any
god Dn 1157, 16" ®15%h non-god(s) Dt 327, — 2.
the true God Jb 34.

{pg 17)

Holds5 017N

Il EI"'HBH [ 2260 =), with waw Ps 1847 14310 145
T, cs. IOR, of TIPN, TN, DTN,
TITIOR; w. pref. DWIPND, ‘N1, 'RD, 'R, but

"W Ps 85 (F 113): — 1. gods, k5l-*16hé migrayim
Ex 1212, "15hé halshim God of gods Dt 107,
“8|5him Sheddm (B4 =, F “ahér), b'né(ha) lahim Gh Gz
sons of the gods (oth.; sons of God) Jb 16 24 357,

T, cf. 08 "Elim; — 2. as a sg.; God, Deity, a) fim.
the form, occasionally construed as pl., hit* "815him
Gn 2013, ™16him hayyim living God Dt 522; b)

Pulsando sobre el boton derecho del ratén en la ‘“Word Analysis Window”
nos aparece un menu contextual que no va a dar la siguientes posibilidades:
Copy &nalyzizs Window Test to Clipboard
Copy Analyziz Windaw Test to Editar

IJpdate Only *»hen Shift Key Depressed

Strong's Dizplay Options

Default Strong's Language

Default &nalyziz Window Greek Lexicon
Default &nalyziz Window Hebrew Lexicon
Lemma/Farm zage Statistics

v v v w v

o Copy Analysis Window Text to Clipboard: copia en el
portapapeles el texto seleccionado.

o Copy Analysis Window Text to Editor: copia al editor de
Bibleworks el texto seleccionado.
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o Update Only When Shift Key Depressed: normalmente la
World Analysis Window se actualiza cuando se mueve el
cursor del ratén salvo que la tecla Shift este presionada.

o Strong's Display Options, Default Strong's Language: esta
opcion permite especificar como se va a mostrar los nimeros
de referencia ‘“Strong Numbers” o elegir el idioma del
lexicon que deseamos (sdlo disponible en algunos casos).

o Default Analysis Window Greek Lexicon, Default Analysis
Window Hebrew Lexicon: permite especificar lexicon griego
o hebreo que se visualiza.

o Lemmal/Form Usage Statistics: para las versiones griega y
hebrea podemos optar para que se nos muestra informacion
de uso de algunas palabras.

¢ The Resource Summary Window: contiene tres tipos de informacion:
o Si la palabra debajo del cursor tiene una entrada en un lexicén
o varios. Se mostrara la primera frase de la misma y un enlace al
texto completo.
o Si el versiculo tiene alguna referencia en alguno de los
recursos, se mostrara una entrada por cada referencia.
o En algunos casos se incluyen referencias gramaticales donde la
particular morfologia es comentada.

Surmnrmary | Le:-ciu:u:unsl Grammarsl Heferencesl Dptinnsl

“The Resource Summary Window” esta compuesta de 5 pestaias. La primera
recoge la informacién léxica y gramatical. Las tres siguientes nos muestran los
diferentes léxicos, gramaticas, obras de referencia con la que esta trabajando
Bibleworks. Nos permite seleccionar las que mas nos convenga aunque por
defecto estan todas seleccionadas.

Por ultimo la pestaia “Options” permite establecer opciones de configuracion de
la “Resource Summary Window’’ como son:

¢ Show Biblical Reference Citations: si esta activado muestra los diferentes
sitios donde el versiculo en el que estamos es citado.

¢ Show Topical Links: si esta activada muestra los links a otras referencias
sobre todo de caracter gramatical.
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